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1. Overview

This guide covers the preparation, data migration, and installation instructions for moving your practice
to Sycle Noah Sync (SNS).

This process and guide are structured accordingly for installing or upgrading SNS. Summaries of the
instructions are below.

1.1. Installation Summary
This is a summary of the workflow and instructions provided for a first-time installation of SNS. This
summary (and the guide in general) assumes that you have an existing Noah installation on either a
standalone Noah database (on a single PC) or using a shared office database.

In the Obtaining an Upload Link and a Conversion License chapter:

• Days (preferably about a week) prior to migrating your Noah data and installing Sycle Noah Sync,
you contact Sycle's Customer Experience Team (at 888.881.7925 or support@sycle.net) to obtain
◦ an upload link for your exported Noah patient data, and
◦ a Noah Conversion key (used to convert your Noah System license to a Noah Engine license)

In the Installing Sycle Noah Sync chapter, you are instructed to:

• Review the requirements before proceeding with the installation (Installation Requirements, page
3)

• Back up your Noah System data (Creating a Noah System Data Backup, page 5)
• Export and upload your Noah System data file to Sycle (Exporting and Uploading Noah System

Data, page 7)
• Convert your Noah System license to a Noah Engine license (Converting the Noah License, page 13)
• Install the software (Running the Installation, page 15)

1.2. Upgrade Summary
This is a summary of the workflow and instructions provided for upgrading an existing SNS installation.

In the Upgrading Sycle Noah Sync chapter, you are instructed to:

• Review the requirements before proceeding with the upgrade (Sycle Noah Sync (SNS) Upgrade
Requirements, page 21)

• Back up your Noah directories (Backing Up the Noah Directory, page 22)
• Install the upgrade (Running the Upgrade, page 24)
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2. Obtaining an Upload Link and a Conversion License

Prior to migrating your Noah data and installing Sycle Noah Sync, you need to contact the Sycle
Customer Experience Team. Ideally, this should be done some days (preferably a week) before you
perform the migration.

CE will provide you with a link that you will use to upload your exported Noah System data (in the
Exporting and Uploading Noah System Data chapter). They will also provide a Noah Conversion key
that you will use to convert your Noah System license to a Noah Engine license (in the Converting the
Noah License chapter).

You can contact the Customer Experience team by calling 888.881.7925 or by emailing
support@sycle.net.

If you already have SNS installed, do not proceed with the instructions in this chapter.
Instead, refer to Upgrading Sycle Noah Sync, page 21.

If you choose to call the CE team at 888.881.7925:

☐ Be ready to provide CE with an email address that you can access on the PC containing your
Noah installation.

☐ Have the registration number (a 16 digit alpha-numeric code) associated with your current Noah
license ready. Your registration code can be found on the Proof-of-Purchase certificate.

☐ Inform CE that you are performing a migration from Noah (standalone) to Sycle Noah sync.

☐ Provide CE with a timeline for the migration.

If you email the CE team at support@sycle.net, do the following:

☐ Ensure you can access the email address used to send the message to CE on the PC containing
your Noah installation.

☐ Indicate that you are performing a migration from Noah (standalone) to Sycle Noah sync in the
title/body of the email.

☐ Provide a timeline for the installation and migration.

☐ Provide the registration number (a 16 digit alpha-numeric code) associated with your current
Noah license in the email message. Your registration code can be found on the Proof-of-
Purchase certificate.

☐ Confirm the email address used to send the message is the correct email address to send your
conversion key and upload link.

When you have the upload link and conversion key, you are ready to perform the migration and
installation. Proceed to Installing Sycle Noah Sync, page 3.
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3. Installing Sycle Noah Sync

Installing Sycle Noah Sync (SNS) is a multi-step process that involves backing up your Noah System
data, exporting and uploading your Noah System data file, converting your Noah System license to a
Noah Engine license, and installing the software.

If you already have SNS installed, do not proceed with the instructions in this chapter.
Instead, refer to Upgrading Sycle Noah Sync, page 21.

3.1. Installation Requirements
Before you proceed with installing SNS, ensure that the following requirements are met. You may
require assistance from your system administrator or IT department.

☐ You will not need to make any changes to NOAH patient data in the next 24–36 hours.
Sycle recommends that you perform this migration after business hours and/or on a Friday to
minimize any operation impact.

☐ If you have any third-party Noah modules installed, you have consulted your module
manufacturers and confirmed that those modules are compatible with the version of Noah
incorporated in SNS.

☐ Your PC is running one of the operating systems supported by SNS and Noah System 4.
◦ Windows 11 – Excluding Windows 11 on Arm and Insider Preview builds.
◦ Windows 10 – Excluding Long Term Service Channel/Branch (LTSC/LTSB) releases, Windows

10 Mobile OS, Windows 10 in S mode, Windows 10 on Arm, and Insider Preview builds.
◦ Windows Server 2022/2019/2016 – Excluding Windows Server Core and Nano Server.

☐ Your PC meets the other minimum system requirements for Noah System 41.

☐ Your Windows operating system has the latest Windows Updates and Service Packs applied.

☐ You know the administrator username and password for your PC. The installer must be run as an
administrator account2.

☐ (Windows 11) Your network profile type is set to Private3.

☐ You, your system administrator, or your IT department are aware of any non-Microsoft antivirus
programs or firewalls installed on your PC and are able to disable them for the duration of the
installation process.

☐ (If applicable) Your system administrator or IT department are aware of the installation timeline
and are available to offer assistance.

1These requirements are listed in the Minimum system requirements for Noah System 4 article on http://www.himsa.com.
2The Administrator account must be set up with a valid password. Running the installer with an Administrator account without a
password will fail.
3Instructions for changing your network profile type are available from Microsoft. See the Make a network public or private
section of the Essential Network Settings and Tasks in Windows article on support.microsoft.com.
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☐ You have obtained and have access to the upload link provided by the Sycle Customer
Experience Team (see Obtaining an Upload Link and a Conversion License, page 2).

☐ You have obtained and have access to the Noah Conversion key (provided by the Sycle Customer
Experience Team) that you will use to convert your Noah System license to a Noah Engine
license (see Obtaining an Upload Link and a Conversion License, page 2).
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3.2. Migrating Noah System Data
The Noah System's patient data must be backed up (for redundancy), exported, uploaded to Sycle, and
your Noah System license converted to a Noah Engine license before you install Sycle Noah Sync.

3.2.1. Creating a Noah System Data Backup
The patient data on your Noah System must be backed up. This ensures you can restore your Noah
database if there are problems with the migration.

These instructions assume that the default database backup location is configured. You can verify your
configured backup location in the Noah Console by navigating to Database Tools → Backup Scheduler
and reviewing the Backup Location → Location field.

If you are using a custom backup location outside the C:\ProgramData\HIMSA\* directory (such as
an external storage device or a network share), follow only Step 1 and Step 2.

These steps must be performed immediately before installing Sycle Noah Sync, and at
a time when no changes will be made to patient data for the next 24–36 hours (see
Installation Requirements, page 3).

This guide assumes that you are migrating either a standalone Noah database (on a
single PC) or using a shared office database. If using a shared office database, ensure
all steps are performed on the PC running the shared office database (i.e. your Noah
Server).

1. Open the Noah Console.

The Noah Console can be opened from the Noah software (File → Noah Console)
or from Windows (Programs → HIMSA → Noah Console)

2. Navigate to and click Noah Console Tools → Database Administration → Tools → Backup
3. In Windows Explorer, navigate to C:\ProgramData\HIMSA.

If you can not see the ProgramData directory in C:\, enter the full path directly in
your Windows Explorer address bar and press Enter.
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If the above directory does not exist, navigate instead to C:\Program Files
(x86)\HIMSA.

4. Copy the Noah directory from C:\ProgramData\HIMSA to a secondary location. This example
uses the local PC's Desktop.

If the above directory does not exist, copy the Noah 4 directory from C:\Program
Files (x86)\HIMSA to the secondary location using the same steps.

a. Click the Noah directory and press CTRL+C to copy the directory.

b. Navigate to your secondary location. In this example, we navigate to the Desktop (⊞ Win+D).

c. Press CTRL+V to paste the directory to your secondary location.
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3.2.2. Exporting and Uploading Noah System Data
After you have backed up your Noah System data (Creating a Noah System Data Backup, page 5), you
must export your patient data and upload it to Sycle.

These steps must be performed immediately before installing Sycle Noah Sync, and at
a time when no changes will be made to patient data for the next 24–36 hours (see
Installation Requirements, page 3).

This guide assumes that you are migrating either a standalone Noah database (on a
single PC) or using a shared office database. If using a shared office database, ensure
all steps are performed on the PC running the shared office database (i.e. your Noah
Server).

Exporting Noah System Data

1. In your Noah software, navigate to and click File → Export Patients.
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2. In the Export Options window, do the following:

a. Select Under Patients for exporting → All patients.
b. Select What would you like to do with exported patients? → Use in another Noah installation

OR for e-mailing patient data.
c. Under Use in another Noah installation OR for e-mailing patient data, deselect the Include

Fast Data Viewing reports in the export and Encrypt with password options.

These options are enabled by default. Ensure these fields are disabled enabled
before proceeding. Disabling these options is required for Noah to export the
patient data in the .nhax format required for Sycle to import your data to Sycle
Noah Sync.

These fields will not appear on versions of Noah lower than Noah 4.9.

d. Click OK or Export.
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3. In the Export Note window, enter the Intended Recipient as Sycle, LLC and the Purpose of Export
as Migration. Click Save.

This window will not appear on versions of Noah lower than Noah 4.10.

4. In the Save As window, navigate to a location where you will save the file, then do the following:
a. In the File Name field, enter the name of the file in the following format:

PCXXXX-Clinic Name-Date

Dates should be in ISO 8601 format, e.g. YYYY-MM-DD.

An example file name would be PC0001-Vancouver Clinic-2023-01-26

b. In the Save as Type field, select NHAX files (*.nhax).
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c. Click Save.
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Uploading Noah Data to Sharefile

1. Open the email provided by the Customer Experience team.

This email was sent as a part of the preparation steps performed in the Obtaining
an Upload Link and a Conversion License chapter.

2. Click the link in the email from the Customer Experience team.

Never click any links in unsolicited emails. If in any doubt about an email message
that seems to originate from Sycle, contact the .Sycle Customer Experience Team.

3. Verify the domain (securesycle.sharefile.com) in your browser's address bar and that the CE
team member's name is shown on the page.

4. Click Browse Files.

5. In the Open window, navigate to and select the PCXXXX-Clinic Name-Date file you exported in
Step 4 of the Exporting Noah System Data instructions chapter and click Open.
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6. Verify the information on screen, then click Upload.

7. Wait for the file upload to complete.

After the file has been uploaded, contact the Sycle Customer Experience Team team by calling
888.881.7925 or by emailing support@sycle.net and verify that the file upload was successful. If the file
upload was successful, proceed to the Converting the Noah License, page 13 chapter.
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3.2.3. Converting the Noah License
You will now use your Noah Conversion key to convert your Noah System license to a Noah Engine
license.

You will need both the Noah Conversion key provided by the Sycle Customer Experience Team (see
Obtaining an Upload Link and a Conversion License, page 2) and the registration number associated
with your current Noah license4.

Converting to and Downloading the Noah Engine License

1. Navigate to the Noah License Registration Page at registration.himsa.dk

You can also open the Noah License Registration Page by navigating to
himsa.com, then selecting Quick Links → Register your Noah license.

2. In the License Registration Number field, enter the Noah Conversion key provided by the
Customer Experience Team and click Submit.

3. Review the License Agreement and click I Agree.
4. On the Noah upgrade page, enter the registration number associated with your current Noah

license4 in the Registration Number field and click Submit.

5. On the Register your Noah License page, verify the accuracy of the information in all fields and
click Submit.

You must contact HIMSA to resolve any inaccuracies on this page.

6. Click Download to download the License.exe file.

Proceed to Running the License Conversion File, page 14.

4This registration number is the same 16 digit alpha-numeric code you provided to CE in the Obtaining an Upload Link and a
Conversion License, page 2 chapter.
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Running the License Conversion File

1. Navigate to your Downloads directory.

On most browsers, the easiest way to view your recent downloads is by opening
the browser and pressing CTRL+J on your keyboard. When the downloads tab
or window appears, you can click the appropriate icon or text to open your
downloads folder (shown below).

2. Right-click the License.exe file and select Run as Administrator.

If file name extensions are not visible on your computer, this file will display
only as License and will not show the .exe extension. This does not affect the
installation process.

3. If the User Account Control window appears, click Yes.

This window may not appear on your device. This does not affect the installation
process and you can ignore this step.

4. When the installer opens, follow the installation instructions on screen to proceed through the
installation.

5. When the installation of the license file is complete, ensure the Result window shows "The NOAH
license file has been successfully installed" and click OK.
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3.3. Running the Installation

1. (If applicable) Pause or disable any non-Microsoft antivirus programs or firewalls installed on your
PC.

2. Open your web browser and navigate to sycle.com/noah-sync-download.
3. Click the download link on that page to download the SNS installer package.
4. Navigate to your Downloads directory.

On most browsers, the easiest way to view your recent downloads is by opening
the browser and pressing CTRL+J on your keyboard. When the downloads tab
or window appears, you can click the appropriate icon or text to open your
downloads folder (shown below).

5. In the Downloads directory, right-click the downloaded installation package and select Extract All.

6. Do not change any of the options in the Extract Compressed (Zipped) Folders window. Click
Extract.

Wait for the files to finish extracting. When the extraction is complete, the location of the extracted
files will open in a new Windows Explorer window.

7. Right-click the setup.exe file and select Run as Administrator.
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If file name extensions are not visible on your computer, this file will display only as
setup and will not show the .exe extension. This does not affect the installation
process.

8. If the User Account Control window appears, click Yes.

This window may not appear on your device. This does not affect the installation
process; simply ignore this step and proceed to Step 9.

9. Wait for the Launching Application window to finish verifying the application requirements. Do not
exit this window manually.

When this step is completed (automatically), the installer closes this window and opens the
Application Run - Security Warning window.

10. In the Application Run - Security Warning window, select Run.
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11. Wait for the Downloading Sycle Noah Sync window to finish the download process. Do not exit
this window manually.

When this step is completed (automatically), the installer closes this window and opens the Sycle
Noah Sync Setup window.

This window may only be briefly visible before it closes automatically. If you do not
see this window, simply proceed to Step 12.

12. Review the contents of the Sycle Noah Sync Setup window. If you have fulfilled the conditions and
requirements (see Installation Requirements, page 3), click Proceed.

CLASSIFICATION: PUBLIC
Sycle Pro Sycle Noah Sync

© 2025 Sycle, LLC. All rights reserved. Page 17



If you have not fulfilled the conditions and requirements (see Installation
Requirements, page 3), this is your last chance to cancel the installation process.
If you have not reviewed the requirements, click Cancel to abort the installation.
When all the requirements have been met, you can start the installation again
from Step 7.

13. Wait for the installer to complete the installation. This process is automatic. Do not close or exit any
of the windows that appear during the installation process.

14. (If applicable) Un-pause or enable any non-Microsoft antivirus programs or firewalls that you
disabled in Step 1.

15. When the installer shows Installation Finished, click Close.

Proceed to Post-Installation, page 19.
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3.4. Post-Installation
The Sycle Customer Experience Team will contact you approximately 24–36 hours after you confirmed
the Noah data was uploaded to Sharefile (see Exporting and Uploading Noah System Data, page 7) to
confirm that your data has been migrated.

Sycle recommends that staff verify that scheduled patients have their hearing session data available
prior to those patients' appointments. There may be unmatched hearing sessions that require manual
matching.

Adapt Unmatched Patient Records
Historical hearing session data is migrated to SNS by matching patients' first and last names and their
date of birth. Unmatched patient records are corrected on the Administration → SNS → NOAH Admin
page.

If you find a patient record that appears to be missing historical hearing data, record that patient's
Patient ID and follow the steps below.

1. Navigate to the Administration screen.
• Click the arrow in the top-left of the screen. From the dropdown menu, select Administration.

2. On the Administration screen, navigate to SNS → NOAH Admin.
3. On the NOAH Admin screen, select a clinic (or all clinics) in the Clinic field.
4. Use the Search field to search for the patient's Noah data using any combination of First Name,

Last Name, DOB, Last Action/Session Date, or Reference data.

The First Name, Last Name, and Date of Birth used in the search are as they were
stored on the NOAH database (not in Sycle).

If you are unable to find the patient, try entering only one parameter; for example,
try only the patient's first or last name, or try just entering the year of their date of
birth.
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5. In the Action field of the matching record, search for and select the matching patient record in
Sycle..

6. Click Process.
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4. Upgrading Sycle Noah Sync

4.1. Sycle Noah Sync (SNS) Upgrade Requirements
Ensure that the following requirements are met before you proceed with the upgrade. You may require
assistance from your system administrator or IT department.

☐ SNS can not be used during the upgrade. The upgrade will take 10–30 minutes depending on
your PC and configuration.

☐ If you have any third-party Noah modules installed, you have consulted your module
manufacturers and confirmed that those modules are compatible with the version of Noah
incorporated in the SNS upgrade.

☐ Your PC is running one of the operating systems supported by SNS and Noah System 4.
◦ Windows 11 – Excluding Windows 11 on Arm and Insider Preview builds.
◦ Windows 10 – Excluding Long Term Service Channel/Branch (LTSC/LTSB) releases, Windows

10 Mobile OS, Windows 10 in S mode, Windows 10 on Arm, and Insider Preview builds.
◦ Windows Server 2022/2019/2016 – Excluding Windows Server Core and Nano Server.

☐ Your PC meets the other minimum system requirements for Noah System 45.

☐ Your Windows operating system has the latest Windows Updates and Service Packs applied.

☐ You know the administrator username and password for your PC. The installer must be run as an
administrator account6.

☐ You, your system administrator, or your IT department are aware of any non-Microsoft antivirus
programs or firewalls installed on your PC and are able to disable them for the duration of the
installation process.

☐ (If applicable) Your system administrator or IT department are aware of the upgrade timeline and
are available to offer assistance.

5These requirements are listed in the Minimum system requirements for Noah System 4 article on http://www.himsa.com.
6The Administrator account must be set up with a valid password. Running the installer with an Administrator account without a
password will fail.
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4.2. Backing Up the Noah Directory
You must back up your Noah files prior to running the upgrade. This ensures you can restore your Noah
data and modules if there are problems with the upgrade.

Backing up your files before proceeding with the upgrade is not optional—it is
mandatory. Failure to create a backup can result in the permanent loss of your current
Noah module settings.

1. In Windows Explorer, navigate to C:\ProgramData\HIMSA.

If you can not see the ProgramData directory in C:\, enter the full path directly in
your Windows Explorer address bar and press Enter.

If the above directory does not exist, navigate instead to C:\Program Files
(x86)\HIMSA.

2. Copy the Noah directory from C:\ProgramData\HIMSA to a secondary location. This example
uses the local PC's Desktop.

If the above directory does not exist, copy the Noah 4 directory from C:\Program
Files (x86)\HIMSA to the secondary location using the same steps.

a. Click the Noah directory and press CTRL+C to copy the directory.

b. Navigate to your secondary location. In this example, we navigate to the Desktop (⊞ Win+D).
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c. Press CTRL+V to paste the directory to your secondary location.

With the backup in place, proceed to Running the Upgrade, page 24.
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4.3. Running the Upgrade

Do not proceed with this section before confirming that the requirements have been
met (Sycle Noah Sync (SNS) Upgrade Requirements, page 21) and your Noah
directory is backed up (Backing Up the Noah Directory, page 22).

1. (If applicable) Pause or disable any non-Microsoft antivirus programs or firewalls installed on your
PC.

2. Open your web browser and navigate to sycle.com/noah-sync-download.
3. Click the download link on that page to download the SNS upgrade package.
4. Navigate to your Downloads directory.

On most browsers, the easiest way to view your recent downloads is by opening
the browser and pressing CTRL+J on your keyboard. When the downloads tab
or window appears, you can click the appropriate icon or text to open your
downloads folder (shown below).

5. In the Downloads directory, right-click the downloaded upgrade package and select Extract All.

6. Do not change any of the options in the Extract Compressed (Zipped) Folders window. Click
Extract.
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Wait for the files to finish extracting. When the extraction is complete, the location of the extracted
files will open in a new Windows Explorer window.

7. Right-click the setup.exe file and select Run as Administrator.

If file name extensions are not visible on your computer, this file will display only
as setup and will not show the .exe extension. This does not affect the upgrade
process.

8. If the User Account Control window appears, click Yes.

This window may not appear on your device. This does not affect the upgrade
process; simply ignore this step and proceed to Step 9.

9. Wait for the Launching Application window to finish verifying the application requirements. Do not
exit this window manually.
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When this step is completed (automatically), the installer closes this window and opens the
Application Run - Security Warning window.

This window may only be briefly visible before it closes automatically. If you do not
see this window, simply proceed to Step 10.

10. In the Application Run - Security Warning window, select Run.

11. Wait for the Downloading Sycle Noah Sync window to finish the download process. Do not exit
this window manually.

When this step is completed (automatically), the installer closes this window and opens the Sycle
Noah Sync Setup window.

This window may only be briefly visible before it closes automatically. If you do not
see this window, simply proceed to Step 12.

12. Review the contents of the Sycle Noah Sync Setup window. If you have fulfilled the conditions and
requirements (see Sycle Noah Sync (SNS) Upgrade Requirements, page 21), click Proceed.
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If you have not fulfilled the conditions and requirements (see Sycle Noah Sync
(SNS) Upgrade Requirements, page 21), this is your last chance to cancel the
upgrade process. If you have not reviewed the requirements, click Cancel to abort
the upgrade. When all the requirements have been met, you can start the upgrade
again from Step 7.

13. Wait for the installer to complete the upgrade. This process is automatic.
If you are prompted to close any applications before continuing the upgrade, select Automatically
close applications and attempt to restart them after setup is complete and click OK.

Do not close or exit any other windows that appear during the upgrade process.
14. When the installer shows Installation Finished, click Close.
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15. (If applicable) Un-pause or enable any non-Microsoft antivirus programs or firewalls that you
disabled in Step 1.

16. (If applicable) Repeat this procedure for all other PCs running SNS.
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Appendix A. Glossary

Glossary
The following terms are used in this document:

Patient ID An automatically-generated identification number used to accurately
match patients' data within and across Sycle.

Patient IDs can be seen on the Patient Summary screen.

Sycle Customer Experience
Team

Sycle's dedicated team is just a phone call or email away.

For sales, training or support requests, call 888.881.7925.

You can also contact the team via email at support@sycle.net.

Sycle Noah Sync (SNS) Sycle's SNS offers the ability to store your Noah data securely in
the cloud, letting you share data between workstations and locations
with no special networking configuration required. A patient's entire
audiological record is available for view from any clinic that has access
to the patient record.
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Appendix B. Document Revision History

Rev # Date Description

1.6 2025-06-02 • Added network profile type set to Private as a requirement for
Windows 11 PCs to Installation Requirements, page 3.

1.5 2025-05-01 • Changed URL of the Sycle Noah Sync download/upgrade package
download page.

1.4 2025-04-30 • Removed upgrade path from Sycle Noah Sync (SNS) Upgrade
Requirements, page 21 as Noah's upgrade path information is only
applicable when upgrading the database used by Noah Systems
and does not apply to Noah 4-compatible business systems.

1.3 2025-03-13 • Fixed version-specific step in Adapt Unmatched Patient Records,
page 19 being included in the wrong versions of the document.

1.2 2025-02-07 • Updated instructions in Sycle Noah Sync (SNS) Upgrade
Requirements, page 21 and the caution admonition in Running the
Upgrade, page 24 to contact Sycle if current version lower than 4.9
to 4.14.

• Added new warning admonition to Backing Up the Noah Directory,
page 22.

• Added new important admonition to Running the Upgrade, page
24.

• Corrected some minor typographic errors.

1.1 2024-10-23 • Added Post-Installation, page 19 chapter with the Adapt
Unmatched Patient Records, page 19 section.

1.0 2023-04-17 • Changed directory structure in Creating a Noah System Data
Backup, page 5 to include the entire /Noah (or Noah 4) directory.

• Added Backing Up the Noah Directory, page 22 chapter to Upgrade
section.

• Added instruction in Sycle Noah Sync (SNS) Upgrade Requirements,
page 21 to contact CE if current version lower than 4.9.

• Added caution admonition to Running the Upgrade, page 24 for
users to contact CE if current version lower than 4.9.

• Added the upgrade backup instructions to the summary in
Overview, page 1.

• Document classification changed to Public. Removed Confidential
label, Legal Notice, and watermark.

0.3 2023-04-12 • Minor changes to sentence structure in Sycle Noah Sync (SNS)
Upgrade Requirements, page 21.
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Rev # Date Description

0.2 2023-04-04 • Added Overview, page 1 and the summaries of instructions.
• Updated installation and upgrade requirements.
• Changed download link for SNS installer package

from sycle.com/pricing-features/noah-sync/ to
sycle.com/noah-synch-download.

• Added installation/upgrade steps for disabling and re-enabling any
non-Microsoft anti-virus or firewall programs.

0.1 2023-03-31 Initial document creation.
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